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Introduction

With this guide, you will explore what you can do with the RSA306, RSA306B, RSA503A, RSA507A, RSA603A, and
RSA607A USB spectrum analyzers. Applications range from simple frequency / amplitude measurements of RF
signals to real-time and modulation analysis that provide you with a complete system view of your device under test.
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Check list for the demo
Before beginning the demo, please be sure you have the following items:

Item Illustration
RSA USB spectrum analyzer

RTSA demo board

USB Y-cable (to power the board)
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Item Illustration
N-BNC adapter

Whip antenna

BNC cable

USB 3.0 cable
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Item Illustration
N-N Cable (2) (Tracking Generator)

10 dB Type-N attenuator (Tracking Generator)

Bandpass Filter, 1500 to 1620 MHz (Tracking Generator)

N-N Male Adapter (Tracking Generator)
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Demo guide overview

Over-the-air demo
The Tektronix RSA300 Series, RSA500A Series, and RSA600A Series USB spectrum analyzers can perform off-air
applications. This demo shows how to use the analyzer for these applications. Using the whip antenna provided with
the analyzer demonstration kit, you can demodulate and listen to the signals from the local FM broadcasting station,
see the realtime spectrum of the signals in the ISM band created by your smart phone, and use the analyzer in
interference-hunting.

■ Demo 1: FM listening
■ Demo 2: ISM band DPX

EMI spurious search
From the first wireless transmissions, electromagnetic interference (EMI) has been a concern for design engineers.
General-purpose spectrum analyzers that contain appropriate filters and detectors are often employed in diagnostics
and pre-compliance, as they are fast measurement tools that often are already used in the design process and do not
require additional capital expense.

■ Demo 3: EMI spurious

 Introduction

RSA Self-Guided Demo 5



Fundamental operations of spectrum analyzers
The Tektronix RSA USB Signal Analyzers have the ability to perform basic spectrum measurements that most
Spectrum Analyzer users are already accustomed to. The goal of these demonstrations is to show how these
instruments perform these basic spectrum analyzer capabilities.

■ Demo 4: Basic spectrum measurements with markers
■ Demo 5: Power measurements with markers
■ Demo 6: Traces and detectors
■ Demo 7: Save and recall

Real-time DPX
Two of the most challenging types of signals to identify and capture are low-level signals close to your signal
frequency and rarely-occurring transients. Sometimes the interference is so infrequent that you can’t detect it at all.
You suspect it is there because of seemingly-random errors. DPX Spectrum instantly demystifies these situations by
displaying a clear image of the offending signals. Its capture probability is 100% for transients as short as 100 μsec.

■ Demo 8: DPX and transient capture
■ Demo 9: Transient capture: Mask test and act on violation
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Modulation
Digital modulation is used in virtually all modern communication systems. These systems have penetrated every
aspect of our lives at a rapid pace. The growth has put increased stress on the ability to quickly and efficiently
analyze a wide variety of digital modulation schemes. In some cases, general modulation schemes have been
included in complex standards with rigorous specifications involving manual test procedures according to these
standards that require lengthy test setups with skilled engineers. Analog modulation is the most fundamental
modulation method, and is frequently used to demonstrate principles in education labs.

■ Demo 10: Analog modulation analysis
■ Demo 11: Digital modulation analysis

Tracking generator
The tracking generator in the RSA500A Series and RSA600A Series analyzers enables some basic network
measurements to be made, thereby providing additional capability beyond basic spectrum analysis. The internal
bridge plus a vector calibration routine enables the instrument to make vector-calibrated measurements of return
loss, VSWR, cable attenuation and distance-to-fault (DTF).

■ Demo 12: Transmission gain measurement
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Setup
As with any test, one of the first steps is to connect the instrument to the device under test. For the initial exploration,
a demo board has been provided to output signals needed for the demo. After you’ve completed the demo and have
gained an understanding of how the USB RSA operates, connect to your own system and see how the analyzer can
help in your day-to-day work.

1. Install SignalVu-PC
■ Install the SignalVu-PC software onto your PC. You can download the software from www.tektronix.com/

downloads, or it is available on the flash drive that is provided with the RSA306.

2. Set up the RSA
■ Power the RSA by connecting the USB 3.0 cable to the USB 3.0 port of your PC.
■ Install the N-BNC adaptor on the RSA.

3. Setup the demo board
■ Connect one end of the USB Y-Cable to the demo board.
■ Connect the other end of the USB Y-Cable to 2 USB ports either on your PC or a separate USB power

supply.
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4. Connect the RSA to the demo board
■ Connect one end of the BNC cable to the RF port of the RSA.
■ Connect the other end of the BNC cable to the RF port of the board.

 Introduction
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Installing SignalVu-PC
SignalVu-PC can be downloaded from the Tektronix.com or included in the USB drive in the box.

1. Use Windows Explorer to navigate to the folder you extracted from the archive.

2. Double-click Setup.exe. Follow the on-screen instructions to install the software.

3. When installation is almost complete, a dialog box will appear to let you choose if you want to install TekVISA.
TekVISA is optimized for SignalVu-PC, especially for instrument searching, and is the recommended VISA
application. You may also use another VISA application, such as NIVISA. To bypass TekVISA installation,
uncheck the box.

NOTE. TekVISA is not required to run SignalVu-PC with Tektronix USB based spectrum analyzers.
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Activating SignalVu-PC
SignalVu-PC SVE is free to use, so no activation is needed. To activate the other options in SignalVu-PC, do the
following:

1. Launch SignalVu-PC. A window will be displayed stating that no license was found.

2. In the dialog, select I have a key--activate now.

3. In the Enter Activation Key text box, enter the activation key for SignalVu-PC.

4. Click OK in the License Activation window. SignalVu-PC will contact the license server and install a license file
provided by the license server.
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Setting up the connection

1. Double click the SignalVu-PC icon on
the Desktop of PC to start the
application. Please wait for the
automatic connection process to
complete before using the software.

If the SignalVu-PC application is already connected to another instrument (either USB or network), an automated
connection will not take place. In this situation, you have to do the following:

 Introduction
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Select Search for Instruments. You
should see the USB connected RSA in the
instrument list. 

1. Select Disconnect from Instrument
to end the existing connection.

2. Select Search for Instruments. You
should see the USB connected RSA
in the instrument list.

3. Select the instrument.

A Connect Status dialog box will
appear to confirm the instrument is
connected and SignalVu-PC can
receive live data from the instrument.
 

A Connect Status dialog box will appear to confirm the instrument is connected and SignalVu-PC can receive live
data from the instrument.
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TIP. Connect

You can quickly verify connection status by looking at the connection indicator square on the menu bar. It is green 
when an instrument is connected. It is red when it is not. You can also view the name of the instrument that is
connected by hovering the mouse indicator over the .

 Introduction
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Demo instructions

Demo 1: FM listening (Demo board not needed)
The RSA300 Series, RSA500A Series, and RSA600A Series USB Signal Analyzers can demodulate audio signals,
which can help you to identify unknown radio signals. You access the Audio Demod tab from the Settings control
panel of the DPX Spectrum plot display. This Demo shows how to use the RSA to demodulate the local FM radio
signals and listen to the programming.

Instructions for the antenna 

1. Connect the provided whip antenna to
the RF input of the RSA.
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Instructions for the RSA 

1. Click the Presets button.

2. In the DPX display, set the CF to
97.75 MHz and the Span to
20.5 MHz.

3. Set the RefLev to -30 dBm.

TIP. FM broadcasting

Throughout the world, the FM broadcast band falls within the VHF part of the radio spectrum. Usually the FM band
starts from 87.5 MHz to 108.0 MHz. (The frequency modulation radio broadcast band in Japan is 76-90 MHz.)

 

4. Right click the screen and then click Marker to peak.
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5. Click To Center in the bottom marker setting area. This sets the center frequency of the analyzer to the center
of the signal.

6. Click the Audio Demod settings.

TIP. Demodulation frequency

The audio listening feature in RSA uses the center frequency of the measurement as the frequency to demodulate
the AM/FM broadcasting signals. You can also input the center frequency directly if you know the frequency of the
radio station you want to listen to.
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7. Select FM – 200 kHz as the demodulation.

TIP. Audio on DPX

Audio Demodulation is also available when DPX display is running, but the sound quality may be degraded
depending on the processor of the host PC.

8. Click Run to start listening to the FM radio signal.

9. Adjust the Audio Gain setting so you can hear the demodulated signal. The sound level is also affected by
the setting of the Windows volume control.

10. Click the Browse… button to select the location you want to save the steam file.

11. Enable the Activate button to start saving the audio, and disable the button when you want to stop saving.
The saved audio format is .wav, which can be played by Windows media player in your PC.

The screenshot below shows the RSA is tuned to 91.5 MHz center frequency to listen the local FM
broadcasting. Drag the marker to other spectrum peaks, center the peaks, and listen to the programming at
other channels. 
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Demo 2: ISM band DPX (Demo board not needed)
The real time streaming of the RSA combined with the DPX processing of the SignalVu-PC software is designed to
address the measurement challenges associated with dynamic RF signals such as the bursted packet transmissions
of WLAN and Bluetooth. Combo devices that use both Bluetooth and 802.11b/g/n WLAN networks have a unique set
of RF interference problems because they share the same 2.4 GHz Industrial/Scientific/Medical (ISM) frequency
band. In this example, we will explore this real-world problem using a whip antenna. The demonstration relies on
WLAN and Bluetooth signals from a tablet, phone or PC that you can control on or off.

Instructions for the antenna 

1. Keep the whip antenna attached to
the RF input on the RSA as in the last
example.
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Instructions for the RSA 

1. Click the Preset button.

2. Click the Select Displays icon
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3. In General Signal Viewing, select
DPX from the Available displays box.

4. Click the Add button. This will add the
DPX icon to the Selected Displays
box (and remove it from the Available
displays box).

5. Select the Spectrum display.

6. Click Remove.

7. Click the OK button.
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TIP. Internal preamp

In the RSA500A/600A, users have access
to turn the internal preamplifier on and off.
You can click Amplitude control panel,
and under the Internal Settings tab,
select the Internal Preamp. This will
improve the sensitivity of the
measurements.

 

TIP. 2.4 GHz WLAN channels

There are 14 channels designated in the 2.4 GHz range (2400–2483.5 MHz) spaced 5 MHz apart. Channels
1 (2412 MHz), 6 (2437 MHz), and 11 (2462 MHz) are the most common channels to choose, and most routers will
use one of them as the default channel.
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8. In the DPX display, set the CF to
2412 MHz or to the center frequency
of one of the WLAN channels. See
the Tip above. Set the Span to
40 MHz.

9. Select the Split view.

10. Set the RefLev to -40 dBm.

11. Click the Settings button.

12. Under the Bitmap Scale tab, set the
Max scale to 3% for the DPX
Spectrum Display.
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13. Under the Ampl Scale tab, set the
Max color scale to -40 dBm for the
DPXogram Display.

14. In the Traces tab, set the Dot
Persistence to Infinite.
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TIP. DPX persistence

You can set the Dot Persistence to be Variable or Infinite.

■ In variable persistence mode, you specify a decay period that limits how long a point will be displayed.
■ In infinite persistence mode, once a point in the display has been written to, it will remain visible indefinitely.

We start with infinite persistence because it ensures that all transients are kept on screen.
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15. Turn the WLAN function Off, then On
in your smart phone/tablet/PC while
monitoring with the setup above.

Check the DPX display to see if you
can see the spectrum of the WLAN
signals. If no signal, you can change
the center frequency of the RSA to
other channels. 

16. Turn the Bluetooth function Off, then
On in your smart phone/tablet/PC
while monitoring with the setup
above.
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TIP. Wi-Fi test mode

To better observe the WLAN activities in
the DPX display, you can cause both
uplink and downlink activity on your device
by navigating to an “internet speed
testing” webpage to test both the
uploading and downloading speed, and
monitor the DPX display of the RSA at the
same time.

 

17. Click Stop to stop the acquisitions when you have a pattern on the spectrogram you would like to examine.

18. Right click the display, and click Add markers twice to add two markers. Then you can measure the distance
between hops in frequency and time using the markers on the spectrogram.
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The following screen shot shows the real time display in the RSA. You can see a typical WLAN interchange between
a nearby smart phone/tablet/PC and a more-distant network access point (AP). The smart phone/tablet/PC signal is
nearly 30 dB stronger than the AP's signal because it is closer to the measurement antenna. At the same screen, you
can also see the Bluetooth signals, and even the measurements of the time and frequency intervals between those
hop signals.
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Demo 3: EMI spurious (Demo board not needed)
The spurious measurement in the RSA is set up to change limits vs. frequency, and antenna correction factors can
be applied. Violations above the user-set limits are shown in red on the table. This example shows how to use the
spurious display in SignalVu-PC and the RSA to perform EMI pre-compliance and diagnostics.

Instructions for the antenna 

1. Connect the whip antenna provided in
the box into the RF input of the RSA.
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Instructions for the RSA 

1. Click Preset.

2. Click the Select Displays icon.
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3. In RF Measurements, select
Spurious from the Available displays
box.

4. Click Add to add the application to
the Selected Displays list.

5. Select the Spectrum icon in the
Selected Displays list.

6. Click Remove to clear the icon from
the list.

7. Click OK.

8. Click the Settings icon.

 Demo instructions

RSA Self-Guided Demo 35



9. In the Scale tab, select the Log scale
to reset the display to show the
frequency axis in a logarithmic scale.

Demo9-Step9

9

TIP. Loss correction

The External Gain/Loss Correction tab under the amplitude control panel ( ) allows you to apply a correction to
a signal to compensate for the use of external equipment, such as an amplifier or attenuator. External loss tables
can be used to apply a frequency dependent gain/loss correction to the signal.
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10. Under the Ranges and Limits tab, click Load... to select the appropriate limit line and measurement
condition.

11. Select FCC Part 15, Rad, Class A (10m).csv for this example.

12. A larger new resized window of the range and limit table can be displayed by clicking Expand.

Demo9-Steps10-12

10

11

12
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You can edit the start and stop range, filter shape, RBW, VBW, detector, threshold and excursion, and limit line.
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After loading the spurious table, your display should look similar to the picture below. The green bar is the loaded
limit line as standards suggest.
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Demo 4: Basic spectrum measurements with markers
When using a spectrum analyzer, one of the first settings is that of the frequency. In this demonstration, we will use
markers to locate the CW signal generated from the demo board, and set the appropriate frequency for the
measurement.

Instructions for the demo board 

1. Press the On button to turn on the
demo board.

2. Set the reference to INT (internal
reference).

3. Set the run mode to FREE RUN.

4. Click the ROW and COLUMN buttons
to select CW as the signal to
generate.
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Instructions for the RSA 

1. Click the Presets button.

2. Click the Settings icon.

3. Click Max Span to set the Span to
the maximum value.

4. Right click the screen, and select
Marker to peak.

5. Click To Center in the bottom marker
setting area. This sets the center
frequency of the analyzer to the
center of the signal.
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TIP. Right Click on Tablet

Touch the screen where you want to right-
click, hold until a complete square
appears, and then lift your finger. The
shortcut menu appears after you lift your
finger.
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TIP. For Tablet users

Activate the on-screen numeric entry of
values and Up/Down controls by selecting
View: Numeric Keypad. When the
Numeric Keypad view is activated, up/
down arrows and a numeric keypad icon
will pop up whenever a field requiring
input is selected. Selecting the 'calculator'
numeric keypad icon will pop up a numeric
entry box.
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6. Set the Span to 40 MHz.

7. Click Peak to locate the center frequency of the signal more precisely.

8. Click To Center again.

9. Right click the screen and select Add marker.
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10. Drag the new marker M1 to the noise level. Notice that readouts show:

■ The amplitude and the frequency of the reference marker (MR).
■ The amplitude and the frequency of the selected marker (M1).
■ The difference (ΔM1) between the selected marker position and the position of the reference marker.

11. Set the RBW to 30 kHz. The RBW setting is located at the left side of the spectrum display.

TIP. RBW

The resolution bandwidth (RBW) determines the fast Fourier transform (FFT) bin size, or the smallest
frequency that can be resolved. Smaller RBW improves the selectivity, but degrades the sweep speed and the
trace update rate.
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TIP. Undo, Redo, and Recall

You can undo anything you do with this  control.

If you are having trouble with this step, recall the setting Demo1_CW.tiq from the directory C:/SignalVu-PC
Files/Example Files. This will give you the correct amplitude, frequency, span and marker settings
automatically. This file also contains data collected from a previous test and creates a trace on screen of the result.
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12. Select Options from the Tools menu.

13. Under the Prefs tab, set the Color
Scheme to Blizzard.
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TIP. Ink Saver Mode

You can print screen images with a white background. Selecting the scheme color to Blizzard makes the
background color changes from black to white in the graphs.
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Demo 5: Power measurements with markers
Integrated power between markers is an easy way to measure the power of a modulated signal without setting up a
channel power measurement. SignalVu-PC performs integrated power and power density measurements using
power markers. When measuring signal density, the signal is assumed to be noise like, and measurements are
corrected to a 1 Hz bandwidth. Selecting power measurement markers automatically switches the trace detector to
Ave (RMS) for accurate results. Integrated power between markers is an easy way to measure the power of a
modulated signal without setting up a dedicated channel power measurement.

Instructions for the demo board 

1. Keep the same setting as the last
demo. Use the ROW and COLUMN
buttons to change the signal type
from CW to OFDM.
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Instructions for the RSA 

1. Keep the same setting as the last demo, or recall the setting Demo1_CW.tiq. Click the Stop button to
pause the measurement.

2. Drag the marker reference (MR) to the left side, and the marker 1 (M1) to the right side, of the OFDM
spectrum.

3. Click the Define button in the Markers toolbar.

4. Within the Marker Properties tab, select Power from the Readouts dropdown menu.

TIP. You can measure phase noise by setting the delta marker to dBc/Hz.

Advanced channel power measurement and ACLR (adjacent channel leakage power ratio) measurement can
be done in “Chan Pwr and ACPR” display.
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Demo 6: Traces and detectors
This demo familiarizes you with the trace detection and function controls available in SignalVu-PC used with the
RSA.

Instructions for the demo board 

1. Keep the same setting (OFDM signal)
as the last demo.

Demo3OFDM

1

Instructions for the RSA 

1. Keep the same setting, or recall the
setting Demo5_OFDM_marker.tiq.
Click Run.

Demo3Step1

1
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2. Right click the screen, and select All
markers off.

Demo3Step2

2

3. Click the Settings icon to display the
Settings control panel.
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4. In the Traces tab, select Trace 1, and
then set Detection to Avg (VRMS)
and Function to Avg (VRMS).

5. Select Trace 2, and then set
Detection to +Peak, Function to Max
Hold, and enable Show.

6. Select the trace to Trace 3, select
Detection to -Peak, Function to Min
Hold, and enable Show.
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TIP. Trace detectors process the data underlying the trace to provide the results you need depending upon your
application. Available detection methods are +Peak, -Peak, Avg (VRMS), Sample, and CISPR Pk.

Trace functions are applied to multiple traces as they are displayed. Available settings are Normal, Average, Max
Hold, and Min Hold. The Number of Traces setting specifies how many traces are averaged.

The same selections are available in the upper left display selection and mouse-over dropdowns.
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The results show the three difference traces displayed in the screen at the same time.

■ The Average trace is generated by multiple traces averaged together. There is one vertical value for each
underlying frequency data point. Once the specified number of traces have been acquired and averaged to
generate the displayed trace, each new trace takes the place of the oldest trace in the calculation.

■ Max Hold trace displays the maximum value in the trace record for each display point. Each new trace display
point is compared to the previous maximum value and the greater value is retained for display and subsequent
comparisons.

■ Min Hold trace displays the minimum value in the trace record for each display point. Each new trace display
point is compared to the previous minimum value and the lesser value is retained for display and subsequent
comparisons.
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TIP. Right-click action menu. You can change marker settings and how waveforms are displayed by using the right-
click Actions menu.
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Select Select marker and adjust their position.
Span zoom Zoom the graph area about the selected point. Right-click in the graph display at a point of interest and drag

to increase or decrease the span about the point of interest. Span zoom adjusts the span control.
CF pan Adjust the center frequency according to horizontal movement.
Zoom Adjust the horizontal and vertical scale of the graph. The first direction with enough movement becomes the

primary scale of adjustment. Adjustment in the secondary direction does not occur until a threshold of
30 pixels of movement is crossed. Drag to the left or down to zoom out and display a smaller waveform
(increases the scale value). Drag to the right or up to zoom in and display a larger waveform (decreases the
scale value).

Pan Adjust the horizontal and vertical position of the waveform. The first direction with enough movement
becomes the primary direction of movement. Movement in the secondary direction does not occur until a
threshold of 30 pixels of movement is crossed.

Marker to peak Move the selected marker to the highest peak. If no marker is turned on, this control automatically adds a
marker.

Add marker Define a new marker located at the horizontal center of the graph.
All markers off Remove all markers.
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Demo 7: Save and recall
In SignalVu-PC, you can save different types of data for later recall and analysis.

Instructions for the demo board 

1. Keep the same setting (OFDM signal)
as the last demo. Demo3OFDM

1
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Instructions for the RSA 

1. Keep the same setting, or recall the
setting Demo6_OFDM_trace.tiq.
Select Save As from the File menu to
open the Save As dialog box.

2. Navigate to the folder where you want
to save the setups, or use the default
location. Enter a file name. Select the
type of file to Acq data with setup
(TIQ)(*.tiq).

3. Click Save.

4. Click the Preset button.

5. Click the Recall icon. Navigate to the
folder containing the .tiq file you just
saved and click Open.
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TIP. Save a User Preset

To save a setup so that it appears in the User Presets window, save it to C:\SignalVu-PC Files\User Presets. The
saved setup will appear in the User Presets window with the name you give the file.
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TIP. File formats you can use to save files

Setup files (Setup) Saves all of the setup information for all displays.
Screen shot (PNG/JPG/
BMP)

Saves a capture of the screen in the specified format.

Results Export files (CSV) Saves the trace and numeric data for the selected display. The trace and numeric data are saved
as CSV files.

Measurement Settings
(TXT)

Saves a list of settings relevant to the selected measurement to a text file. This option is useful for
including the measurement settings in reports.

Trace (Various) Saves a trace for later recall into the display from which it was saved.
Data (TIQ/CSV/MAT) Saves data and measurement setup for analysis later (TIQ format) or as data to use with external

software in either CSV (comma-separated value) or MAT (MATLAB) formats.
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Demo 8: DPX and transient capture
The DPX display helps you to see how traces change over time and displays signal events that cannot be seen on a
swept spectrum analyzer. DPX Spectrum indicates how traces change in two ways. First, it uses color shading to
show how consistent the shape of a trace is. Second, it uses persistence to hold signals on the screen so you can
see them longer. The DPX display reveals transient signal behavior that helps you discover instability, glitches, and
interference.

Instructions for the demo board 

1. Keep the same setting as the last
demo. Use the ROW and COLUMN
buttons to change the signal from
OFDM to Inf Hop (Infrequent hopping
signals).

Demo5InfHop

1
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Instructions for the RSA 

1. Keep the same setting, or recall the
setting Demo6_OFDM_trace.tiq. Click
the Select Displays icon.
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2. In General Signal Viewing, select
DPX from the Available displays box.

3. Click the Add button (or double-click
the DPX icon). This will add the DPX
icon to the Selected Displays box.

4. Click the OK button.

5. In the DPX display, set the CF to 2.4453 GHz and the Span to 40 MHz.

Select the Split view. 
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You can see the hopping signals displayed in the DPX spectrum, and compare it in the standard spectrum
display on the right side. Note that the standard spectrum display nearly or always misses the transient
signal. 
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6. Select the DPX display by clicking
anywhere on it with the mouse, and
click the Settings icon.

7. Under the Bitmap Scale tab, set the
Max scale to 3% for the DPX
Spectrum display.

8. Under the Ampl Scale tab, set the Min
color scale to -80 dBm for the
DPXogram display.

9. Under the Prefs tab, enable Show
parameter readouts.
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TIP. Changing the color scheme

In the “temperature” palette, the highest color (Maximum) is deep red and the lowest (Minimum) is dark blue.
Values between Maximum and Minimum are represented by the other colors of the palette.

 

10. Click Stop to pause the measurement. Right click the DPXogram screen, select Add marker, and drag the
marker to one hopping signal. Then add another marker and drag it to the closest hopping signal. The delta
marker will show the time between two hopping signals is about 1.25 s, or the hop occurs every 1.25 second.

11. You can set the size of the DPX spectrogram by selecting the divider bar between the displays and moving it
up or down to add area to the display of interest.
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TIP. 100% POI

The minimum event duration required to ensure 100% Probability of Intercept (POI) or event capture. It depends on
interaction between span, RBW, and FFT length. You can use the POI time value to determine if you are at risk of
either missing a narrow transient or of its captured amplitude being less than the actual signal. The minimum 100%
POI for RSA306 is 100 μs.
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Demo 9: Transient capture - Mask test and act on violation
The mask test feature in SignalVu-PC allows you to save events of interest automatically and allows you to save an
acquisition file in an open data format and/or a screen capture when a signal in the frequency domain violates the
mask.

Instructions for the demo board 

1. Keep the same setting (Infrequent
hopping signals) as the last demo.

Demo6-InfHop

1

Instructions for the RSA 

1. Keep the same setting or recall the
setting Demo8_DPX.tiq. Click Run.

Demo6-1

1
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2. Under the Tools menu, click Mask
Test….

3. Select DPX: Trace1 in the Search in:
field .

4. Select is outside mask in the Test
for: field.

5. Click Edit limits… to open the Mask
Test Editor.
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6. In the Mask Test Editor, select the
DPX Trace1 as the Reference.

7. Click Auto Draw to generate a mask
automatically adjusted to the
Reference.

8. Click Done.

TIP. Mask Test Editor
■ The margins between the mask and the reference trace can be specified by X Margin and Y Margin.
■ The points can be added, edited, or deleted.
■ You can also create a Frequency Mask by using the manual method.
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9. Under the Actions tab, select Beep, Save acquisition data, Save trace, and Save picture.

10. Click Enable Test.

When a mask violation is detected, the system will sound a beep, and save all your selected format of files
into the selected folder automatically. 
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TIP. Actions for violations
■ The analyzer can take up to five actions when a match occurs. In Run mode, the analyzer can sound a beep,

stop acquisitions, save acquisition data, save trace data, and save a picture of the display. In Replay mode, it
can sound a beep and stop analyzing.

■ Files can be saved in the native format of SignalVu-PC (.tiq), or in comma separated variable (.CSV) or Matlab
level 5 (.MAT) formats.

■ The folder for saving files can be selected from Save as….
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Demo 10: Analog modulation analysis
Analog modulation is the most fundamental modulation method. The analog modulation analysis feature in the RSAs
provides measurements to demodulate and analyze amplitude modulation (AM), frequency modulation (FM), and
phase modulation (PM). This example shows how to analyze an FM signal with an RSA.

Instructions for the demo board 

1. Keep the same setting as the last
demo. Use the ROW and COLUMN
buttons to change the signal type
from Inf Hop to FM (frequency
modulation signals).

Demo7-FM

1
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Instructions for the RSA 

1. Click the Preset button.

2. Click the Select Displays icon.
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3. In General Signal Viewing, select
DPX from the Available displays box.

4. Click the Add button. This will add the
DPX icon to the Selected Displays
box (and remove it from the Available
displays box).
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5. In Analog Modulation, select FM from
the Available displays box.

6. Click the Add button.

7. Click the OK button.

TIP. Selecting displays
■ You can also double-click the desired display to add or remove it.
■ Five application presets are available for the display selection.

 Demo instructions

RSA Self-Guided Demo 79



 

8. Select the DPX display by clicking anywhere on it with the mouse, and set the CF to 2.445315 GHz and the
Span to 500 kHz.

9. Click the Analysis control button.

10. Under the Analysis Time tab, set the Analysis Length to 10 ms.

11. Click the FM display, and then click the settings button.
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12. Under the Parameters tab, set the
Measurement BW to 200 kHz.

NOTE. FM measurements readout
■ +Pk: positive frequency deviation
■ –Pk: negative frequency deviation
■ RMS: RMS value of the deviation
■ Pk-Pk: peak-to-peak frequency deviation
■ Pk-Pk/2: peak-to-peak frequency deviation divided by two
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Demo 11: Digital modulation analysis
The General Purpose Digital Modulation Analysis provides vector signal analyzer functionality. A wide variety of
modulation types are supported, allowing you to view your signals in Constellation, Eye and Trellis diagrams,
measure the quality of the modulation, display time-domain waveforms for demodulated I & Q signals, EVM, Phase
Error, Magnitude Error, and more. This example shows how to demodulate a QPSK signal with an RSA. This
demonstration also introduces the concept of application presets to quickly set up for complex analysis tasks. This
demonstration relies on the optional modulation analysis capabilities of SignalVu-PC. If you are using a basic version
of SignalVu-PC, a trial license for this analysis can be accessed through the Tools > Licenses > Manage menu of the
software.

Instructions for the demo board 

1. Use the ROW and COLUMN buttons
to change the signal type from FM to
QPSK1.

Demo8-QPSK

1
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Instructions for the RSA 

1. In the Presets menu, click
Application.

Step1

1
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2. Select Modulation Analysis for the
Preset.

3. Click OK.

4. Click the DPX display and set the CF to 2.445315 GHz and the Span to 10 MHz.
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TIP. Save setups as User Presets

To save setups so that they appear in the User Presets window, save your setup in the folder C:\SignalVu-PC
Files\User Presets. The saved setup will appear in the User Presets window with the name you give the file.
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5. Click the Constellation display icon in
the Application Presets window, and
then click the Settings icon.

6. Under the Modulation Params tab,
select QPSK from the Modulation
Type list, set the Symbol Rate to
3.072 MHz, set Measurement Filter to
Root raised cosine, Reference Filter
to Raised cosine, and Filter
parameter to 0.350.

7. Click the Stop button.

8. Right click the screen and select Add
Marker.

9. Drag the marker to any cell in the
Symbol Table. This sets the marker
(MR) time value to the starting time
for the cell containing the marker.
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10. Look for MR in the Constellation
graph. Move the marker to different
cells in the Symbol Table.

TIP. Modulation filters

In most modulation schemes, signals are filtered to reduce the bandwidth prior to transmission. When the signal
under test has been passed through a modulation filter, a matching Measurement Filter should be selected in the
instrument in order to interpret symbols properly. The Reference Filter, while not used for demodulation, is important
for making the proper error vector measurement calculations. This filter will normally be defined by the modulation/
demodulation standard.

TIP. Symbol table

Each symbol value is assigned a position in the Constellation diagram. The Symbol Table will be used to
demonstrate the mapping between quadrants in the Constellation diagram and the symbol values.
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TIP. Correlated display

Not only are all the displays correlated through the shared data set, but the markers, which are inherently correlated,
make it very easy to see how a data point in one domain relates to a specific data point in any other. This can greatly
reduce troubleshooting time.

Demo 12: Transmission gain measurement (tracking generator needed, available on
the RSA500/600 series)

A tracking generator (TG) creates a signal present at the center frequency of the spectrum analyzer (SA), so that
when the analyzer is swept or stepped across a frequency range, the tracking generator signal is always present.
Connecting the TG output to the SA input produces an un-normalized frequency response curve that contains the
errors in frequency response due to the generator, analyzer and the connecting cable. These can be removed by
running a calibration in the tracking generator application. The measurements made with this type of normalization is
done are scalar measurements, and vector parameters are not used.

Demo instructions  

90 RSA Self-Guided Demo



 Demo instructions

RSA Self-Guided Demo 91



The RSA500A Series and RSA600A Series analyzers contain an internal bridge at the output of the tracking
generator. This plus a vector calibration routine enables the instrument to make vector-calibrated measurements of
return loss, VSWR, cable attenuation and distance-to-fault (DTF). When the application SV60 is used, the instrument
uses a factory calibration of vector parameters at the plane of the output of the tracking generator. In many cases,
this calibration yields sufficient measurement accuracy, and no further calibration is required. Should user-calibration
be desired, either for best accuracy, or to move the measurement plane from the front panel (for example, if you'd like
to remove a length of connecting cable from the measurement results), calibration kits for Open/Short/Load are
available for this. For further information on option SV60, please contact your local Tektronix Sales Representative.
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Calibration 

1. Make sure the RSA500A/600A is
connected to the host PC and then
run SignalVu-PC.
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2. Click Select Display button.

3. Select Spectrum from the box of
selected displays.

4. Click Remove to remove the
spectrum display.

5. Select Transmission Gain from the
box of Available displays.

6. Click Add.

7. Click OK.

If no cable is connected to the RSA, you may not find the trace on the screen. 
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8. Connect the attenuators, cables, and
through connector to the RSA.

You should see the trace now, and it is the trace without any calibration. 

TIP. Tracking Generator Option

To make any tracking generator measurements in SignalVu-PC, please make sure you have a RSA500A/600A
with hardware Option 04. Otherwise, the measurements will not be shown in "Available Displays".
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9. Click Setting control panel.

10. Set the Start Freq and Stop Freq
according to your device under test.
In this example, we set 500 MHz as
the start frequency and 2.5 GHz as
the stop frequency.

11. Set the RBW. Lower RBW can
reduce the noise floor of the
measurement, but may take longer to
measure.

12. Set the number of Steps. The higher
the number, the more time it takes.
101 steps is recommended as the
starting point.

13. Under Prefs tab, enable Show
measurement points, if desired.

14. Click Calibrate….
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Once you enter the Calibration display, you will see the information of the calibrated condition it made last time,
and the change from the last calibration. 

15. Click Perform Calibration….
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16. Click Calibrate, and wait until the
calibration finished.

Observe the trace line after the calibration.
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Attenuator Test 

1. Under the Traces tab, select Freeze
to keep the current trace (Trace 1) in
screen for comparison later.

2. Keep the cables and the through
connector, and connect the device
under test to the cables.

In this example, we test a 10 dB
attenuator. 
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3. Under the Traces tab, select Trace 2
in Trace.

4. Select Show.

5. Observe the transmission gain of the
attenuator from the trace 2 (the
orange trace). It should have 10 dB
difference to the blue line (without
attenuator).

6. Click Autoscale for a higher
resolution display.
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1. Keep the cables and the through
connector. Remove the 10 dB
attenuator. In this example, we
connect a 1500-1620 MHz band pass
filter as the device under test.

2. Adjust the Scale and Position by
clicking . You can also adjust the
scale and position manually.

3. Right click the display, and click .
Then you can move the marker to see
the detail of the gain trace.
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You can see the gain response of the band pass filter.
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Example I bandpass filter test.
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Example II bandpass filter test.
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